
FO 4311/6311 - Spatial Technologies Laboratory 13
GIS/ArcMap View Graphics / Spatial Analysis / Database Query/ Graphic Output

In this exercise, you will learn how to enhance your view by drawing additional graphics and text. You
will also learn different ways to extract information from established data sets by use of spatial analysis
and database query tools. These operations form the cornerstones for basic GIS information extraction
concepts. Remember that the commands you are learning here are comprehensive and will be used
throughout the exercises. DO NOT TREAT THIS AS A COOKBOOK. You need to take time to
experiment with the different ways that you can accomplish the things outlined in these exercises. As you
start each new exercise, make sure to clean up after yourself (get rid of old layers).

1. Review and Practice Layer Drawing
Start a new view and bring up the roads, lakes, streams, and ccstands01 Layers. Modify the Layer
legends and practice using the zoom and pan features

2. Adding Text

Select the text button ( ) and add text to your view. This toolbar is usually found on the bottom of the
screen. Experiment with different fonts and sizes. Label Hwy. 25, Dorman Lake, Cypress Creek Unit.

3. Draw Shapes

Experiment with the different shapes selected from the draw tool button ( ). You can draw points,
lines, rectangles, circles (ovals), irregular, and polygons (this is a drag down menu). The characteristics
of shapes (line style, color/hatch, fill, etc.) can be modified by right-clicking inside the shape and
selecting properties. These features work much like popular PC Paint and other simple graphics packages.
You can move and resize graphics with the select (arrow) button. 

4. Simple Query Review
Try selecting features using the identify tool

How is the information presented using the information button?

___________________________________________________________

5. Note at any time you can zoom to the selected layer by right-clicking on the layer in the data legend and
selecting the Zoom to Layer option.  
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6. Find ( )
Find is used to search attribute tables. Use the ccstands01 layer with the Find tool to identify the
occurrence of Pine in the coverage. By right-clicking in the result box you are presented a number
of options on how to identify the stands. Make sure you can see the layer before you identify it.

 
7. Selecting Features by Graphics

To select features that fall within or overlap a shape you first draw the graphic shape (step 3)
onto your screen. Next you need to select the layers that you want to select attributes from by
going to Set Selectable Layers in the Selection menu. Finally you will use the Select by graphic
button to identify all features in the selected layers that are overlapped by that shape. 

Try drawing an approximate 1-mile radius circle around the shop area of the Starr Forest (Noxubee
Unit near Hwy. 25) with the ccstands01 layer selected. As you drag your circle, the radius is given
in the lower left part of the ArcMap screen (you will not get exactly one mile). Next, with the
stands Layer selected, click the Select by graphic button. This should highlight all stands that fall
all or in-part within one mile of the shop.

8. The Select by Attribute Function
The Select by Attribute Function opens a window that can be used to develop complex database
queries. Combinations of fields and values are used with math and Boolean operators to select the
features of interest based on their attributes. Queries are based on defining sets of geographic
features that meet qualifications that you define. The user can create a new selection, add to
current selection, remove from current selection, and select from current selection. This is
done by putting together logical expressions that select the features of interest based on feature
attributes. Rather than type the expressions, fields, operators and values are selected by double
clicks on the items or operators you wish to use in your expression. The keyboard can also be used
to type in numeric values or correct the syntax of an expression. Bring up the Cypress Creek stands
layer and make it the active layer. Try to generate the following query: ([acre]<50). Double click
on the field (acre) you want, click on the operator (<) then type in 50 after the operator in the
query window. Remember to select Create a New Selection after constructing the expression.
Clear the previous expression by deleting everything between the outside ()_s. Next select from
that query (Select from current selection) the following: ([Mgt_type]=“Pine”). Next select from
that query (Select from current selection) the following: ([Cond_class]=“sawtimber”). Zoom in
on the Cypress Creek (NW) unit. 

How many stands fit this query in the Cypress Creek Unit?__________

Next try doing the same query by using the complex expression: ([acre]<50) and ([Mgt_type]
=“Pine”) and ([Cond_Class]=”sawtimber”) and select Create a New Selection.

Clear your selections from these queries before proceeding.
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9. Features from Tables

You can select features by highlighting records in the attribute tables.

Open the attribute table for the CCstands01 layer.  Click on records to select them. The control
key can be used to select more than one record at a time.  When you select the feature you should
see it highlighted in the attribute table and in the Data view. 

Bring up the forest stands coverage and select stand # 16. 

Where is this stand located (unit)?____________________

How many acres are in the stand?_______________

What is the forest type of the stand?_________________

Clear all of your selections before the next exercise.

10. Select by Location
You can select features in one Layer based on selections of features in another layer.

First bring up the TWstands01 and soils layers. Create a query that selects the soil type Ur from
the soils layer (step 8). Next choose Select by location from the selection menu and set it up so
that all Talking Warrior stands are selected that have a soil type of Ur. 

Open the TWstands01 attribute table and answer:

How many stands remain selected?_____________

11. Tabular Results
Open the TWstands01 attribute table and construct a query to ask for all Pine/Hardwood stands.
Choose the Selected button at the bottom of the attribute table to view only the selected
Pine/Hardwood stands. With this new table active, you can select a field (column) and right-click
on the title to go to the Field pull-down menu to ask for summary information. Select the acre
column and give the following statistics:

Mean: _________acres 

Sum: __________acreage.
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12. GIS/ArcView Graphic Output

This portion of the lab exercise will concentrate on development of output products based on
information derived from the Starr Forest GIS. Make sure to bring printer paper and a diskette. You
will want to save your final project work to diskette. Do not eject your diskette while the computer
is accessing it.

“A picture is worth a thousand words.”

A. Charts
This part of the lab will familiarize you with basic charting capabilities and how charts can be used
to enhance the presentation of data from query processes. Start a new map view and add the soils
layer and adjust the color to your taste. Next zoom in on the Talking Warrior unit. Open the
attribute table to bring up a table of all polygon features in the soils Layer. The polygons in the
Talking Warrior unit will be at the top of this table.

Select four or five polygon records in the table by using the left mouse button and the control key
on your keyboard. Click the Options button at the bottom of the table and select Create Graph.
This should open a Graph Wizard that is very similar to the one used in Microsoft Excel. 

Go through the wizard menus and create a graph of the acreages of your selection stands. There are
a number of options to use in the graph wizard, so take time to explore which set-up best displays
the type of data you are trying to present. When you finish with the graph wizard, your graph
should appear in the center of the screen. If you cannot see it, you may need to minimize the size
of your attribute table.

By clicking in the graph display you can bring up the information for that specific attribute. If you
want to edit the properties of the graph you can right-click on the header bar for the graph and
select properties.
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B. Layouts
This part of the exercise will concentrate on development of map output products from your data.

Start a new map view and display some layers of interest. Set the color scheme so that the layers 
will be visible when printing in black and white. Once you have the layers the way that you want 
to display them, select Layout View from the View menu. You can select the Page Setup option 
under the File menu to select which way you want to orient the paper (choose from the printer 
setup side). 

If you want a specific map scale (RF) right-click in the Data Frame in which your layers are 
presented and select properties. Find the data frame tab and then select the fixed scale button and 
enter your desired scale. 

Take time to explore the other tabs that are available and how they can be used to enhance your 
map. 

Add a north arrow, scale bar, legend and other text by using the Insert menu. Experiment with 
different layout looks. Remember all maps should have a title (what it is, who did work, who is it 
for, when was it done), legend (describes symbology), source of data, scale bar, and north arrow. 
The elements of your layout can be scaled and positioned interactively with your mouse using the 
same methods used for moving and scaling other graphics.

Make sure that you can make a map that both displays the data that you want displayed and also 
does it in a well organized and neat manner. Half of your points on the final project are based on 
the presentation of your map!
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Name:________________________                               Section:_______________________

Lab Exercise 13. Query Practice and Map Layout Practice

1) Start a new map view.

2) Bring in the Lakes, Roads, TWstands01, and Soils layers and color code according to your tastes.

3) Arrange so that you can see the lakes, stands, and roads.

4) Make the Talking Warrior Unit stands the active Layer.

5) Construct a query and identify the closest stand to Dorman Lake with a management type attribute of
“Pine/Hardwood.” (Hint: use measurement tool as well)

What is the area of the stand in acres?_____________

What is the perimeter of the stand in feet?__________________________

How far from Dorman lake is the stand?___________________________

Can the stand be reached by road?________________

6) Use the query builder to select the single stand from part 5 above based on its Stand number.
(use information button to get the ID number). Your new query should be constructed so that only
that stand closest to Dorman Lake with the “Pine/Hardwood” management type is now selected.

7) Do a Select by Location selection to find out what soil types occur in the selected “Pine/Hardwood”
stand. List the soil codes___________________________________

8) Use the Talking Warrior Unit to create a map:
a. Add the stands, roads, and lakes Layers

b. Change the stand Layer to unique value and management type

c. Put a square box (approximately 5,700 ft) around the Dorman Lake area

d. Change the stand type colors/legend within the square to diagonals, horizontal lines, etc. so that
you can distinguish in black and white the major types of pine, hardwood, pine-hardwood, research
area, and food plot.

e. Add text labels to the various types and lake within the square box.

f. Create a layout at a scale of 1:12,000 with scale bar, legend, north arrow, and proper title.

g. Print out final map to turn in.
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